
Understanding Final Cut
Pro’s Interface: An Overview

� Activating Windows

� The Browser Window

� The Viewer Window

� The Canvas Window

� The Timeline Window

� The Tool Palette

� Workshop 3: Load the First Project and Become Familiar with 
the Navigational Controls and Window Arrangement

Activating Windows
Clicking various windows activates them. The Canvas and Timeline acti-
vation commands and some of the commands in the drop-down menus
across the top are gray and unavailable if the proper window is not 
activated. You can see which window is active by looking at the title bar
at the top of each window. The activated window has a lighter gray color
in its header than the other windows’ headers.

A great way to activate any of the four major windows is to use the
appropriate keyboard shortcut:

� Cmd+1 activates the Viewer window.

� Cmd+2 activates the Canvas window.

� Cmd+3 activates the Timeline window.

� Cmd+4 activates the Browser window.

CHAPTER 3

04 2816_CH03  11/11/03  12:43 PM  Page 55



56 Jerry Hofmann on Final Cut Pro 4

What you do in each window can affect what happens in another. Figure 3.1 shows
an alternative view of the interface, created by simply dragging the four windows
around and resizing them accordingly.

Timeline
Window

FIGURE 3.1 The four major windows.

The first window we’ll discuss in greater detail is the Browser window, which you can
see by pressing Cmd+4.

The Browser Window
The Browser window, shown in Figure 3.2, is where you organize your source mate-
rial and keep your edited sequences. It’s a visual list of records that is displayed as
icons next to names. This window also contains information about your source
material and your edit decisions. These records are not the media files; they are
pointer files to the separate media files you have captured, digitized, or copied into
your computer’s hard drives for use in your project.

Viewer Window

CanvasBrowser
Window
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FIGURE 3.2 The Browser window.

The Browser window stores a reference file to every element your project contains.
You’ll probably also end up storing elements you didn’t use in your finished program
here. You drag these clips around the interface to move shots or elements into your
edited program.

There are two tabs in the most basic setup of this window. One is the Project tab
(named “FCP Project 1” in Figure 3.2), which contains the pointer files, and the other
is the Effects tab, which contains a logically sorted list of available effects. If the
Effects tab is not present, you can activate it from the menus by selecting Window,
Effects or by pressing Cmd+5. You can bring it forward in the Browser by clicking its
tab (see Figure 3.3). Your project will have its own tab at the top of this window.
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FIGURE 3.3 The Effects tab in the Browser window.

You can have as many projects open at the same time as you want, and you can edit
between them. You can close these tabs by Ctrl-clicking (click while holding down
the Ctrl key) the tab and invoking the Close Tab command (see Figure 3.4). The
Close Tab menu is just one of many pop-up context menus that are available in
many places around the interface. We’ll explore them as we edit our movie. You can
close the whole Browser window by clicking the button in the upper-left corner.

FIGURE 3.4 The Close Tab menu.
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Types of Reference Files
Many types of elements are contained in the Browser window, as shown in Figure 3.5.
Each element has its own icon (the little picture to the left of the clip name). An
audio-only clip (the little speaker), a graphic clip (the little square with ABC on it),
and a still frame of video each has its own icon, giving you a visual reference as to
what type of element it is.

FIGURE 3.5 The Browser window with all types of elements referenced in Final Cut Pro.

Clips are reference files that reference individual moving picture, still, and/or sound
elements such as QuickTime files, CD audio files, and still frames. Master clips have
square icons. These square clips contain video and might or might not contain audio.
If they do contain audio, it is usually the sound that was recorded at the same time
the pictures were recorded (sync sound).

There is a way to “marry” an audio clip to a video clip. New to FCP 4 is the ability to
merge clips. A merged clip is typically an audio file you’ve “married” to a video file.
You can merge as many as 24 audio tracks to a single video file, for example. A great
use of this feature is to sync your sound to a video clip, such as in the case of a film
shoot where you’ve recorded audio on a DAT machine. When you edit with a merged
clip, the synchronized audio and video act as if it was a single media file. You can
merge up to 24 different audio tracks to one another without a video track.

To merge a clip, highlight the video (or audio) clip in the Browser and an audio clip
you find useful for a merge, and Ctrl-click one of the two or more selected clips. The
Merge Clips window opens, as shown in Figure 3.6. Select the appropriate method
for FCP to merge the clips, and click OK. Final Cut Pro creates a new clip that, when
opened, acts like a single audio/video file. It also renames this new clip with the
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video file’s name with the word “merged” added to the end. In the case of merging
only audio clips, the topmost clip’s name is used, with the word “merged” added to
the end.

FIGURE 3.6 The Merge Clips dialog box.

After they are created, the only change you can make to these clips is a subframe
audio slip. A way to re-create a merged clip is to edit it into a sequence and then
delete the original merged clip in the Browser. Then, unlink the items in the
Timeline and make any sync changes. (To unlink clips in the Timeline, use the tog-
gle button in the top-right  area of the Timeline window, or press Shift+L.) Relink the
clips (just click the linking button again or press Shift+L) and then drag them back
into the Browser from the Timeline to create a new merged clip.

Sequences contain these clips, all your edit decisions, and your finished program. A
sequence icon is a box with yellow and blue boxes within it. You can create as many
sequences and clips as you want. This comes in handy for different edited versions
of the same material or different areas of your finished programs. You can use mul-
tiple sequences in many other ways, such as for a series of similar shots or a sequence
for each scene of your feature film.

You can edit from sequence to sequence too, not just from clips. One way is to copy
and paste a clip or set of clips between sequences. You can even add an entire
sequence to another sequence by dragging its icon to the other sequence in the
Timeline window, creating a nest. A nest appears to be a single clip, but it contains
the contents of its source sequence. It’s similar to what After Effects calls a precom-
position and similar to what happens in Avid when you collapse a sequence. When
you add an entire sequence by dragging its icon to another sequence, you see a sin-
gle clip, but if you double-click this nested clip, its source sequence of clips opens in
the Timeline window. Any changes made to this source sequence are reflected in the
nested clip that is contained in the sequence you add it to.
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A subclip is a portion of a clip you’ve set apart as an element you can quickly access.
For example, this could be a single shot from a media file or a master clip (any origi-
nal media file) that began as an entire tape with many shots. The subclip icon has
serrated edges. You can make subclips from subclips. You can make subclips from
audio-only clips, but their icons remain the same as what the audio-only master clip
uses (the speaker icon). We’ll use subclips extensively as we edit the film.

When clips are offline, they have a red line through them. Offline in this context
means that no picture or sound files (media files) connect to them.

The rest of the icons are as follows (see Figure 3.5):

� Video transition—An effect between clips, such as a dissolve

� Audio transition—An effect between audio clips, such as a fade or audio dissolve

� Video filter—An effect applied to a video clip

� Audio filter—An effect applied to an audio clip

� Video generator—Effects that Final Cut Pro makes, such as to a title or color bar

� Marker—A reference point within a clip

� Graphic file—Pict files or tiffs are examples

� Audio-only clip—Contains no video

The Browser window also can contain bins. They are represented by blue folders that
can contain clips, sequences, subclips, or even more bins to reduce clutter and organize
your source material.

Also notice in Figure 3.5 the little triangles next to the bins and one of the master
clips. These collapsible triangles, called disclosure triangles, open and close the bins or
open and close the list of markers contained in a clip or subclip. Triangles that point
down are open. Triangles that point toward the icon are closed. The bin or clip 
closes and opens another area for viewing items simultaneously. To open and close
them, simply click them.

You can have as many sequences and clips stored in the Browser window as you want,
but for good order, you should store clips in a logical bin structure. The icons are
actually buttons you click to command Final Cut Pro to call up the media files to play
for you in the Viewer window or Canvas window. (See the sections “The Viewer
Window” and “The Canvas Window.”) If you click the names of these items, you can
type a name for them. When clicking the icon of these files, you can drag them or
open them in the Viewer, Canvas, and Timeline windows.
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This entire display of references (clips, sequences, and effects), as stored and dis-
played in the Browser window and project settings, comprises the content of the pro-
ject file. Because the project files are only text files, you can easily back them up on
all sorts of different media away from the computer. A large project file might be
15MB in size. Backup has to be a way of life for intensive work such as editing. You
definitely don’t want to lose the log or the editing that’s been done. It’s a great habit
to back up your project file at the end of each session on media that can be stored
away from the computer.

The Importance of Backing Up Your Project File
A word to the wise: More than one editor has lost his job because he failed to back up
his project file. Think of what could happen if you edited something for months and
then lost the use of your project file. I never want to be in that position, and I’m sure
you don’t either. Disaster happens from time to time during the life of any nonlinear
editor (NLE), so don’t get caught on this one. Backing up is absolutely the most impor-
tant computer chore for anyone.

Final Cut Pro can open a saved project file and recapture it on any Mac that runs the
same or a newer version of Final Cut Pro. It recaptures all time-coded source material
contained in these logs automatically in a process called batch capture. You can find
further discussion of backup and recapture strategies in Appendix C, “Solving Common
Problems.” Media files such as video captures are quite large and might be too cumber-
some to back up. Project files, though, are much smaller and can easily be backed up
on a Zip disc or CD. If you lose your media drives, you can restore your media files
from a backup of your project file. You also can restore all the work you’ve done with
sequences.

There is an auto backup feature within Final Cut Pro called the Autosave Vault, but you
probably will save these backups to your startup disk, and you could lose that disk, so
it’s still best to back up on a Zip disc or a CD at the end of each session. The worst case
is that you could lose a day or two of work, not months’ worth.

Clip Information
Clip information can include reel number, media start and end points, tracks con-
tained, file format information, and more. Clip information is stored in the columns
to the right of the clip names. Figure 3.7 shows only a portion of them; you can use
the arrows or the bar at the bottom of the Browser window to scroll through them.
I grabbed the handle on the bottom-right corner to expand the Browser.
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FIGURE 3.7 An expanded view of the Browser.

Table 3.1 is a complete list of what clip information can be stored in the columns.

Table 3.1 Columns in the Browser Window

Column Information

Name The clip’s name as you entered it.  

Media Start The time code where your clip begins on your source tape.  

Media End The time code where your clip ends on your source tape.
Length The duration of the entire media file.  

In Point The time code position that is set after you select an edit
start point in the Viewer or Canvas window.  

Out Point The time-code position that is set after you set an edit end-
ing point in the Viewer or Canvas window.  

Duration The duration of the In point to the Out point in hours,
minutes, seconds, and frames.  

Tracks Video and/or audio tracks.  
Good A check mark to quickly sort the best takes feature.  

Audio Specifies whether the clip is stereo, for example.  

Frame Size Expressed as pixels, such as 720×480.  

Compressor Which compressor or codec the clip or sequence uses.  

Data Rate Expressed in kilobytes per second (KBps).  

Audio Rate The clip’s sample rate in KHz.  

Video Rate Expressed in frames per second (fps).  

Audio Format Expressed as bits and format.  

Alpha Displays the type of alpha that FCP detects.  

Reverse Alpha setting Can be set to yes or no. A check mark reverses the current
setting to invert the alpha channel.  

Composite Expressed as a type that is selectable.  
continues
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Pixel aspect Expressed as a ratio.  

Anamorphic A check mark indicates whether the medium is 
anamorphic. You also can set this to force this condition.  

Description A user-entered phrase, for example.  

Scene A place where scene descriptions or numbers can be kept.  

Shot/Take A column for shot or take numbers.  

Reel The number or name of the tape the clip is from.  

Last Modified A date and time.  

Aux TC 1 User-assigned auxiliary time code number 1.  

Aux TC 2 User-assigned auxiliary time code number 2.  

Type A sequence, clip, subclip, or bin.  

Log note Another place to keep notes.  

TC Where the time code is from.  

Size The media file size in bytes. This is great for media-
management decisions.  

Label User-selectable.  

Source Where the medium is stored on your disk drive.  

Thumbnail A user-selectable still frame that displays a user-selectable
frame that the clip contains.  

Comment columns You can have custom names for four user-definable 
comments columns. You can change their names by 
selecting Edit, Project Properties.  

Quite a bit of information is stored in these columns. The information is arranged
much like a spreadsheet, with column headings at the top and the data that’s 
particular to each clip in the rows and columns beneath the top row of column 
headers. What’s exciting is that all the information is sortable and searchable.
Furthermore, Final Cut Pro gathers much of the information stored here automati-
cally. This automation is a necessity if you are editing a feature-length program with
thousands of clips.

To sort a column, click its header name at the top of a bin or the Browser window.
Click again to reverse the sort. To find a clip, select Edit, Find or press Cmd+F. You
can also use the up and down arrows on the keyboard to move the highlight from 

Table 3.1 continued

Column Information
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element to element in this project/display—again, much like a spreadsheet. Pressing
letter keys moves the highlight between clips whose name starts with that letter.
When the clip or sequence is highlighted, you can press the Return key to load the
clip or sequence from the Browser into the Viewer, Canvas, and Timeline windows.

By dragging the column name headers, you can move the columns to the position of
your choice. This powerful feature allows you to quickly view the information of your
choice next to the Name column, for example.

You can also add or take away columns from your view by Ctrl-clicking any column
header. A context menu opens, as shown in Figure 3.8. You also can save and restore
custom column layouts from this menu. These layouts are saved in the
User>Library>Preferences>Final Cut Pro User Data>Column Layouts folder. New in
Final Cut Pro 4, these layouts can be moved from system to system.

FIGURE 3.8 The Browser Column context menu.

You can resize the Browser window by dragging the lower-right corner of the window
or clicking its green expansion button to expand its view. Keep the Browser window
handy, because you select all source material for your sequence or edited show from
this window. The sidebar gives you a quick lesson on some automatic arrangements
that can come in handy.

Arranging Those Four Windows
Using the Window menu, you can arrange Final Cut Pro in many ways. Saving frequently
used window arrangements for tasks you perform often enhances your monitor setup. 
If you have multiple monitors or a cinema display, your standard window arrangements

continues
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might be different from a person who has just one 15-inch monitor. Accessing these 
window arrangements is a snap. Just pull down the Window menu to access some
arrangements that Final Cut Pro supplies, and then start with one you like. Modify the
arrangement by dragging the windows to where you want to work with them, and then
Cmd-click and select Window, Arrange, Save Custom Layout 1 or 2. Alternatively, you can
set this new custom arrangement to be accessed through keyboard shortcuts.

Final Cut Pro then has this setting available when you work in this particular project. If
you want to use this setting in any or all projects, you need to create a custom layout.
After you’ve set up the windows as you want them to be, save them by selecting
Window, Arrange, Save Layout. After you have saved the windows, you can restore
them in any project by selecting Window, Arrange, Restore Layout. When you select
this command, you see a window that allows you to select any of the saved layouts
you’ve created for this or earlier projects.

Viewing Options in the Browser Window
There are four ways to look at items in the Browser: the List View, and three different icon
views. Figure 3.9 shows the Large Icons view. To access the context menu shown in Figure
3.9, Ctrl-click a blank area of the Browser or an open bin. Note the Arrange option.
Selecting this in one of the three icon views forces the pictures to fit into the Browser.

FIGURE 3.9 The Large Icons view.
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Three other views are listed in the context menu shown in Figure 3.9: Small Icons,
Medium Icons, and Large Icons. Experimenting with them is your best bet. When
you select these views, the clip information is replaced by a representative frame of
the clip in the case of video clips and by larger views of the icons in the case of the
other types of files.

You can open a separate bin window by double-clicking its icon in the Browser. You
can use all but the List view to arrange your clips in a certain order by dragging them
around and then dragging them as a group to the Timeline in order from left to right
and then top to bottom. It’s sort of like creating a storyboard and then dragging it to
the Timeline in the order of your choice. You can trim these complete shots with the
tools supplied by Final Cut Pro.

The Arrange selection in the pop-up menu arranges the icon views to fit the pictures
into the window shape you are currently working in.

One other context menu can be opened from this window. If you Ctrl-click a clip icon,
you can pull up a set of commands to use on that selection, as shown in Figure 3.10.

FIGURE 3.10 The context menu containing commands available for an item in the Browser.

The Effects tab, shown in Figure 3.11, contains all the effects you have at your dis-
posal within Final Cut Pro. They are organized into six folders. If you open the 
triangle next to one of the folders, you can see the list of effects that can be applied
to your clips and edit points.
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The difference between a filter and a transition, whether it’s video or audio, is in how
it’s applied. A filter applies to a clip or a portion of a clip (such as a color correction),
and a transition is an effect used between two clips (such as a dissolve). Some are
audio-only filters and transitions, and some are video-only filters and transitions.

FIGURE 3.11 The Effects tab.

In the Favorites folder, you can drag any effect you have customized for quick access
as you edit. In the Video Generators folder, you can access all the elements you can
create from within Final Cut Pro, such as titles, shapes, gradients, highlights, noise,
and audio tone. There are also plug-ins that can be added to Final Cut Pro, such as
Boris’s Graffiti and Boris’s Red. They too show up in this window as generators if they
have been added to your system. Note that there are no audio + video filters. Each of
these elements must be affected separately.

You can add plug-in effects such as After Effects filters, which show up and are sort-
ed into the appropriate effect categories accessed under this tab.

To add a filter or transition to audio or video, drag the effect from the Effects tab to
the clip or cut point you want to affect.
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The Viewer Window
The Viewer window, shown in Figure 3.12, is like a QuickTime movie player on
steroids. Not only can you view clips and have full VTR-like controls while viewing
them, but you can also modify any clip’s playback, view source time code, edit from
it to a sequence in various ways, and modify all your program’s effects. Durations of
transitions, amounts of color changes you make, keying parameters, and more are
programmed from this seemingly simple window. Used primarily for viewing and
marking source material to be added to your program, this window is where you can
edit most parameters of all the elements in your finished program, whether they are
clips or effects.

FIGURE 3.12 The Viewer window.

You can open clips into the Viewer window from the Browser by simply dragging
them from the Browser to the Viewer or by double-clicking them. You can load
sequence clips from your current sequence for further editing, adding, and modify-
ing of effect parameters by double-clicking them in the Timeline window. Also you
can open sequences in the Viewer by dragging them from the Browser to the Viewer.
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Buttons in the Viewer Window
The controls and buttons in this window look familiar. They work much like the
controls a videotape recorder (VTR) uses (see Figure 3.13). The round center button
turns playback on and off. The button to the right of it is “Play Around Current
Frame.” This button lets you go back a bit, play through the current position, and
then play past it a bit. How far it goes back and then plays past your current position
depends on what you’ve set in the User Preferences General window in the preview
pre and post roll boxes. It’s a quick way to play before and through an edit point (if
a sequence is loaded in the Viewer) or any position you might be sitting on to check
just the footage around it.

FIGURE 3.13 Controls used in the Viewer window.

The next button on the right is the Next Edit button. It moves the position indica-
tor to the next edit to the right. The button on the far left moves you to the next edit
point to the left of your current position.

The button with the triangle between two lines is Play In to Out. This button plays
your clip from your set In point to your set Out point. The shuttle control on the left
scans your material forward or backward; the farther you move from center, the
faster the playback goes in either direction. The control on the far-right is the jog
control. It performs much slower searching.

The scrubber bar resides just above these VTR controls. It represents the clip’s entire
duration. The yellow position indicator resides here as well; it’s also called the play-
head. You can click anywhere in this bar to quickly move about within the clip you
are working with.

Mark
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Current Frame

Generator
Button

Mark
Clip

Playback Recent
Clips

Add Keyframe

Add
Marker

Mark
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Next Edit
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The buttons along the bottom left are as follows:

� Match Frame—Pulls up the same frame if it’s in the current sequence into the
Canvas window.

� Mark Clip—Selects the clip’s boundaries to set an In point at its beginning and
an Out point at its end.

� Add Keyframe—Adds a keyframe at the current position. Keyframes are markers
that set certain frames to become a start, an ending, or even a midpoint for an
effect to start or end.

� Add Marker—Adds a marker to the current position. This button has many uses
that are explored throughout this book.

� Mark In—Sets the clip’s In point at the current position, where you want to see
it start in your edited program.

� Mark Out—Sets the clip’s Out point at the current position, where you want
playback of this clip to end in your edited program.

The two buttons on the bottom right are Recent Clips and Generator. The Recent Clips
button, on the left, lists the clips you’ve recently loaded into the Viewer window. You
set the number of clips displayed in the User Preferences General window, but this
number is lost each time you close Final Cut Pro. The Generator button is quite a dif-
ferent animal. It lists items you can create in Final Cut Pro. You can open titles, bars,
tone, gradients, matte colors, and more in the Viewer window by selecting them here.
This is discussed in detail in Chapter 11, “Video Filter Effects and Basic Compositing.”

At the top of this window are two time-code displays, three buttons, and a series of
tabs. The right time-code display shows the duration of an unmarked clip. It changes
to show the duration between an In point and an Out point. Ctrl-click it to pull up
a pop-up menu, as shown in Figure 3.14. You can display the time as Drop Frame,
Non-Drop Frame, or Frames. The sidebar explains the differences between the two
time-code formats. Selecting Frames counts the number of frames from in to out or
for the duration of the clip if you have not set these points yet. Durations can also be
used to define in and Out points. When you set either point and then type a dura-
tion into the box, FCP sets the companion point (in or out) for you.

FIGURE 3.14 The time-code views context pop-up menu.
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The left time-code display shows the time code that is associated with the current
frame you are viewing. It also works as a time-code locator. Type in the time code you
want to go to, and as long as the clip in the Viewer contains that number, the Viewer
displays the frame stamped with that number. You don’t need to type the colons or
semicolons. FCP knows that the colons and semicolons are part of the number you
are looking for. For example, if you want to type 1 minute, type 10000 for 1 minute,
0 seconds, and 0 frames. If you like, you can avoid adding the 0s by typing periods.
For example, 1. equals 1 second, 1.. equals 1 minute, and 1... equals 1 hour.

Drop Frame and Non-Drop Frame Time Codes
Professional videotape formats include a time code, which is a unique number
“stamped” on each frame of video. It is displayed as hours, minutes, seconds, and
frames: 00:00:00:00. The difference between the Drop Frame and Non-Drop Frame
time codes is that Non-Drop Frame (expressed as colons between the numbers) counts
each frame of video in ascending order, changing over the count from 00:00:00:29 
(29 frames) to 1 second, expressed as 00:00:01:00. The problem is that NTSC video 
is not 30 frames per second. It’s 29.97 frames per second.

If you used the Non-Drop Frame code to set an in point at the beginning of your fin-
ished program and an out point at the end to have Final Cut Pro calculate your pro-
ject’s duration, using the Non-Drop Frame code would result in an incorrect duration.
This could be disastrous for editing programs that must come to definite time dura-
tions, as all broadcast programs must do.

Enter the Drop Frame time code, which is expressed as pairs of numbers separated by
colons, but with semicolons at the end in Final Cut Pro. At each minute changeover, 
the numbering system drops the numbers between the fifty-ninth second and the
twenty-eighth frame and the next minute point, which starts at that minute and one
frame. This numbering scheme “drops” two frame numbers. Thus, frame number
00;00;59;28 is followed by frame number 00;01;00;01. This numbering system skips
the dropping scheme at each 10-minute changeover. If you do the math, this works
out over a period of actual time, and you can rely on the duration of your edited
sequence to be the actual time that is calculated using this form of time code. Most
professionals use the Drop Frame code, so this “real” time problem doesn’t exist. 
FCP can search for clips if you enter time-code numbers. If you are using Drop Frame
by entering time-code numbers, and you enter a number that is not in the sequence
because it was dropped, FCP displays a frame assigned with the next-higher number.

As long as your sequence uses the Drop Frame time code, it doesn’t matter if your
source material uses Non-Drop Frame. The timing will still be correct as long as the
sequence uses the Drop Frame code.

PAL video is always 25 frames per second and always uses the Non-Drop Frame time code.
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The three oval buttons near the top of the Viewer window in the middle control dif-
ferent viewing options as well as a new behavior that Final Cut Pro 4 introduces.
(We’ll discuss these buttons in depth as we edit our movie.) The button on the left
zooms in or out on your clip. It invokes a command to automatically fit to the 
window size you’ve set up for viewing purposes. The button on the right selects
options such as time-code overlays and title safe. The new button, in the center (it
looks a bit like football goalposts), selects playback behaviors. It’s called the Playback
Sync button, and it has four options, as shown in Figure 3.15:

� Off—This is the default behavior. The Viewer and Canvas windows play inde-
pendently from each other.

� Follow—Playback in the Viewer is locked to the playback of the Canvas window.
Viewer and Canvas display the same frame. As you move the Canvas’s playhead,
the same frame appears in the Viewer. This is called ganging. Note that if the
source clip is not already loaded into the Viewer, the Viewer’s playhead does not
follow along.

� Open—This is similar to the Follow option, except that it automatically loads
any clip in the Viewer that the playhead of the Canvas or Timeline is currently
viewing. This can be useful for quick alterations to various clips next to each
other in your sequence that need to be colorcorrected, for example. The active
tab in the Viewer stays open, but the clips loaded in the Viewer match the clips
you currently are viewing in the Canvas, and what you see in the Viewer is the
color correction visual controls of the Canvas’s clip.

� Gang—When this option is chosen, the offset between the position of the play-
head in the Canvas and the position of the playhead in the Viewer is maintained
as both playheads move together. This mode can be useful for editing operations
in which you want to mark in or Out points using durations defined by clips
already in the Timeline.

FIGURE 3.15 Options on the Playback Sync pop-up menu.
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For example, suppose that before you turn on this option, you set an In point in a
source clip and set the Canvas’s playhead to the In point you want to use in the
sequence as a reference. Moving the Canvas’s playhead to the Out point you want to
reference moves the Viewer’s playhead the same amount forward in time, allowing
you to set or preview in the Viewer the default Out point that will be used, main-
taining the duration you moved the playhead in the Canvas. This is similar to Avid’s
phantom marks. It allows you to see a clip’s default Out point or In point determined
by the in or out of a clip already in your sequence.

Tabs in the Viewer Window
The Viewer window has a number of tabs. To open a tab, click it. The Video tab
shows the video that’s in the clip. The Audio tab displays audio waveforms and
allows you to change levels, edit with keyframes, and pan your sound. There might
be two of these tabs if your clip contains two separate tracks. A single Stereo Track
tab is also seen if the source clip has stereo audio captured with it. In the case of
merged clips, you have as many tabs as you have merged audio tracks with a video
track. In the case of audio-only clips, you see only an Audio tab and an Effects tab.

The Filters tab is where you access controls of effects (filters) you’ve added them to.
They can be audio filters or video filters or both. There also might be a tab for the
Color Corrector, Color Corrector 3-way, and Keyer if you’ve added one or more of
these to the clip that contains them.

Clicking the Motion tab (shown in Figure 3.16) brings up a set of standard tools you
can use on any clip. These include Scale (size), Rotation, Center (determines the
frame’s center point), Anchor Point (the point in the frame that it is set to rotate
around), Crop (where you can cut off some of the picture), Distort (where you can
change the placement of the frame’s four corners), Opacity, adding a Drop Shadow
or Motion Blur to your clip, and Final Cut Pro 4’s new Time Remap feature. I’ve
stretched the window to reveal the entire contents of this tab. The Motion tab is the
basic area for effects. It’s available for use on any video clip.
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FIGURE 3.16 The Motion tab.

The upper bar across the top of the Viewer is a button bar. Here you can drag buttons
for quick access to any command from the button list (press Cmd+J). Just select the
button from the list and drag it to the small “button bounders” in the upper right of
the window. These icons bookend your buttons.

The area next to the controls is a Timeline that represents the duration of the clip cur-
rently being worked with as it appears in the Timeline. After you add a clip to the
Timeline, you double-click it to open it in the Viewer, click the Motion tab, and start
creating effects. Keyframes are added to the light-colored area on the right side of
Figure 3.16. You can add those familiar triangles next to the different effects to a clip.
If you click the triangles, the controls appear, like the Basic Motion effects that are
open in Figure 3.16. As we edit our movie, we’ll use these effects.

When a clip is opened from the sequence Timeline, the part of the clip that is pre-
sent (trimmed) in the Timeline is highlighted, but the clip’s duration is available on
the Motion tab. Note too that the scrubber bar has sprocket hole representations in
it when you address the clip as it is present in the Timeline.

04 2816_CH03  11/11/03  12:44 PM  Page 75



76 Jerry Hofmann on Final Cut Pro 4

The Canvas Window
The Canvas window, shown in Figure 3.17, has many of the same controls as the
Viewer window, but it functions as a window that only plays back and modifies the
clips as edited in your edited sequence. You can have more than one sequence open
at one time, and you can select the active one by clicking its tab at the top of the
Canvas window. You can even have more than one sequence accessible here as well.
You can drag its tab away from the Canvas and view two sequences side by side, 
playing them one at a time. Any sequences open in the Timeline window have 
corresponding tabs to view them from in the Canvas.

FIGURE 3.17 The Canvas window.

You can think of the Viewer window as a source playback or a single clip viewer, and
you can think of the Canvas window as a playback monitor for your edited master-
piece. The Canvas window’s content is completely tied to your edited sequence.
When you play back edited material, it plays back in the Canvas window. When you
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Overwrite
edit

Replace
edit
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close the Canvas window, you also close the Timeline window. Final Cut Pro assumes
that if you don’t want to view a sequence, you don’t need the Canvas window open.
If the Canvas window is closed, you can open it by double-clicking a sequence in the
Browser. Both the Timeline window and the Canvas window open.

All the buttons that look the same as in the Viewer have the same uses, but there 
are some notable differences in the Canvas window. On the bottom left are three 
buttons. They represent edit commands, invoked after you select source material to
add to your sequence that’s active in the Timeline window. The first button inserts
the source material into the edited show, the second overwrites material, and the
third replaces material:

� The Insert edit command adds material selected with in and Out points from the
Viewer to anywhere in your sequence. It also moves all material later than your
selected In point to accommodate this new element. Therefore, an Insert edit
command lengthens the duration of the sequence of shots.

� The Overwrite edit command covers up older material with the new material
selected with in and Out points from the Viewer. The Overwrite edit command
does not lengthen the duration of your sequence.

� The Replace edit command is similar to Overwrite because it covers up material,
but it works a bit differently. The Replace edit puts a new clip in your sequence
by replacing the frame you are currently viewing in the Viewer with the frame
you are currently viewing in the Canvas.

The duration of the edit is calculated in one of two ways: in the sequence in and Out
points you’ve made, or, if none have been set, in the duration of the clip you are
viewing. You must keep in mind that you must have enough source material before
and after the Viewer’s frame to cover up the old clip. This does not change the
Timeline’s duration.

The blue Replace button has a small triangle. This triangle opens a pop-up menu with
even more ways of adding material to your sequence, as shown in Figure 3.18.
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FIGURE 3.18 Pop-up edit command buttons.

Here are the options from left to right:

� Fit to Fill—A four-point edit that calculates the speeding up or slowing down that
is necessary for a source clip’s in and Out point to become the duration you’ve
selected for it by setting in and Out points in your sequence. For example, if you
mark a duration of 1 second in the Viewer and mark an in and Out point with a
duration of 2 seconds in the Canvas, Final Cut Pro places a 2-second clip, which
is a 50% playback speed of your source clip.

� Insert with Transition—Adds the default transition you’ve selected. Final Cut Pro
defaults to a 30-frame dissolve centered on the edit point, unless you’ve changed
the default transition, as discussed in Chapter 5, “Basic Editing.”

� Overwrite with Transition—Does the same as the Overwrite edit, but Overwrite
with Transition adds the default transition you’ve selected. Final Cut Pro
defaults to a 30-frame dissolve centered on the edit point, unless you’ve
changed the default transition.

Superimpose Fit to
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Transition
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The Canvas Window Overlay
The Canvas window overlay, shown in Figure 3.19, lets you access the same functions
as with the Canvas window’s edit buttons. To activate these functions, you drag a clip
from the Browser or Viewer window to the Canvas window and the appropriate over-
lay, to either insert, overwrite, replace, or fit to fill. You also can add the user selec-
table default transition at the same time. This transition will be at the beginning or
In point of the edit. When the ghost image is dragged to one of the edit commands,
a highlight will appear over the command.

FIGURE 3.19 The Canvas window overlay.

Match Frame and Mark Clip Differences
For the most part, the rest of the icons in the Canvas window, which match those in
the Viewer, do the same things as those described for the Viewer window, except that
they work on your sequences. However, the Match Frame and Mark Clip buttons
have different functions. The Match Frame button pulls up the source clip contain-
ing the frame you are currently paused on in the Canvas and puts it in the Viewer.
The Mark Clip button marks only the clip you are currently paused on and only the
top track of audio or video you have targeted by clicking the yellow track indicators
on the left side of the Timeline window.
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The Timeline Window
The Timeline window, shown in Figure 3.20, displays the clips you have edited in
your sequence. This window can contain more than one sequence. You can switch
between sequences by clicking the tab at the top of the window, just as you can click
the tab at the top of the Canvas window.

FIGURE 3.20 The Timeline window.

You can create a new sequence at any time by pressing Cmd+N. The default number
of tracks that this new sequence contains is set in the User Preferences on the
Timeline Options tab (activated from the Final Cut Pro menu). Final Cut Pro defaults
to one track of video and two tracks of audio.

You can add a clip to a sequence contained in this window by either dragging the
clip from the Browser to the sequence or from the Viewer to the sequence, or by
marking the clip in the Viewer and editing it to the Canvas window. There’s not real-
ly a best way. A lot depends on your perception of the easiest way to do this. As we
edit the movie, you’ll discover and use all the ways you can edit from the Browser to
your sequences in the Timeline window.

The Buttons in the Timeline Window
In the upper left of the Timeline window is a pull-down menu that sets the prefer-
ences for FCP 4’s RT Extreme, as shown in Figure 3.21. It allows you to set the play-
back quality of FCP’s real-time effects. Using these options, you can determine what
playback quality you want to work with. You can change it if you’d rather see the RT
play back differently. In other words, you can turn on Unlimited RT and maximize
your computer’s power until you start to drop frames, or you can select Safe RT and
have a reliable, high-quality playback.
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FIGURE 3.21 RT Settings in the Timeline window.

Real-time effects are listed in bold on the Effects menu and on the Browser’s Effects
tab. The number of simultaneous effects that play back in your computer is deter-
mined by the size of your CPU’s Level 3 cache and the speed of your computer’s CPU,
memory bus, hard disks, and graphics card. (Open GL is used to speed up real-time
display and playback.) The faster your machine, the more you get, basically.

The positive side of this is that it might not matter how reliable playback quality is if
you simply want to check out your effects before you render them. No longer do you
have to render, change parameters, and then render again to check your changes.

As soon as you reach your computer’s limits, you either have to reduce the playback
quality using the RT pop-up menu or render the clips you want to view in high quality.

Some capture cards offer some real-time effect support. You can select them from
the User Preferences window in the Playback Control tab. From this window, you
can let FCP handle the effects, or you can let your capture card handle them.

Just to the right of the RT pop-up menu is the time-code display. It shows the cur-
rent time code your playhead is at in the Timeline and Canvas. You can enter a time
code here to quickly jump to a specific time in your sequence.
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Below the RT menu is a list of the tracks your sequence contains (see Figure 3.22).
Here you “target” the tracks you will edit. The track name buttons on the right dis-
play your source material’s tracks (the clip or sequence loaded in the Viewer; notice
that they are lowercase on the left for your source material’s track names, and upper-
case on the right). The track names buttons on the right represent the tracks your
sequence contains.

Auto Select
Controls

Track
Visibility
Controls

Mute 
and Solo
Controls

Audio
Control
Button

Timeline
Time Code

Lock Track
Controls

Clip
Keyframes

Clip
Overlays

Track
Height

Source and
Destination Controls

Zoom Sliders

Zoom Control

FIGURE 3.22 Track controls in the Timeline window.

All you need to do to put, say, a video clip from your Canvas on the V2 track of your
sequence is to drag its track name to be next to the V2 sequence track. The same is true
of audio clips. If your source material contains audio you don’t want to edit into your
program, simply slide the audio track’s source control to the right to “disconnect” it.
The same is true of source video tracks you might not want to include in the edit.

To add tracks to your sequence, simply Ctrl-click in this area and select Add Track.
The same context menu deletes tracks and resets your target tracks to the default 
of v1 to V1, a1 to A1, and a2 to A2. This is handy when you have so many tracks
working at once that scrolling around to change the target track settings isn’t easy.
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The round green buttons with the film or speaker icon just to the left of the
Destination and Source Controls column select which tracks should be played back
or “monitored” when you play your sequence.

Just to the right of the Destination and Source Controls column is a series of locks. If
you click one or more of these locks, those tracks become “locked” and can’t be edit-
ed or changed without being “unlocked.” When you lock a track, a serrated line is
drawn through it. Locking your tracks can be useful if you don’t want your work to
be altered inadvertently. You can, however, add keyframes and set audio levels or
video opacities in the User Preferences General window.

To the right of the locks are Auto Select buttons. Auto Select controls have many uses.
Clicking these buttons determines which track is “match framed.” The highest but-
ton active (lit) is the track that is matched in the Viewer if you invoke the Match
Frame command in the Canvas. These buttons also denote which tracks you’d like to
make a cut with using the Ctrl+V command, which creates an edit point in the mid-
dle of a clip already in your sequence. Final Cut Pro calls these through edits.

Auto Select controls also allow the contents of the selected tracks to be selected via
the Timeline or Canvas windows’ in and Out points. For example, a portion of a clip
is selected to have a filter applied to only that portion, much like a range selection.
But if you use a range selection, these AutoSelect controls are ignored in favor of the
selection made with the Range Selection tool. When you use the Auto Select controls,
you can add filters to the area selected or delete these selections from your sequence.

On the far left in the audio track section are two buttons contained in an oval. The
speaker icon is a Mute control for its associated track, and the headphone icon is a
Solo control. Soloing an audio track means playing only that track and muting all oth-
ers. You can solo more than one track at a time by clicking the solo light of another
track. (This is much faster than clicking a lot of green monitoring lights in order to
focus on two of your possible 99 tracks.)

If the Timeline window doesn’t show these far-left buttons, you can modify it so that
it does by clicking the Audio control (the speaker icon) in the bottom left of the
Timeline window.

In the bottom-left corner of the Timeline are six more buttons:

� Audio control—This is the square button with a speaker icon. It toggles the 
visibility of the Audio Mute and Solo controls.

� Clip Keyframes control—These are the green and blue lines. Clicking this 
button adds a row under each video and audio track to indicate whether an
effect has been applied to any clip (see Figure 3.23). If a filter has been added or
you’ve created a motion effect (or both), you can manipulate its parameters in
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the Timeline window as well as from the filter’s tab in the Viewer after double-
clicking the clip from the sequence. A green line near the top area means that a
filter has been applied. A blue line indicates that a motion effect has been applied.

FIGURE 3.23 The Clip Keyframe area of the Timeline window.

Keyframes added to these filters show up in the bold colored lines. The default
keyboard commands to navigate between keyframes are Shift+K to move your
playhead to the next keyframe later in your sequence and Cmd+K to move your
playhead to the next earlier keyframe.

Figure 3.23 also shows how you bring up any filter or motion settings you want
to manipulate. In the figure, the saturation (amount of color) is set to start at
full color and then slowly drop to black and white from the starting keyframe
to the ending one.

Only one of these keyframeable lines can be open at a time, but it’s a snap to
change which parameter from any number of filters or motion effects you’ve
applied. Just Ctrl-click in the Clip Keyframes area and select the parameter from the
context menu that appears. You can use the pen tool (p) to add, move, raise, or
lower the parameter settings of any give keyframe. You can also use the Selection
tool to raise or lower the level for an entire clip without adding any keyframes.

In the case of audio, green lines representing filters applied are the only colored
lines. Simply put, if there is a line under your video or audio clip, the Timeline
indicates the presence of an effect. If you’ve added keyframes to the effects, they
are displayed here as well, and you can change their parameters from the Timeline
window. We’ll experiment with these controls as we build the movie together.

� Clip Overlays control—This button looks like a line graph. It turns on or off a
black line that runs inside a video clip and a red line that runs inside an audio
clip (see Figure 3.24). In the case of audio, this keyframeable line sets the audio
level. In the case of video, it sets the video’s opacity. You can use the mouse to
set these parameters by selecting the appropriate tool from the Tools palette.
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Use the selection tool to raise or lower this line between keyframes, and use the
pen tool to add, raise, and lower keyframes. Figure 3.24 shows an audio clip’s
levels lowering for a time and then coming back up.

FIGURE 3.24 Clip Overlay activated.

� Track Height control—This button offers four different heights you can select
for viewing your tracks. If you have many tracks, it might be most convenient
to look at them with a short height to see more tracks at once. If you do this,
though, you can’t see things such as audio waveforms inside your audio clips or
precise indications of the clip overlays and their keyframes. So you’ll probably
change this view when you need to for these adjustments to be easier. Pressing
Shift+T repeatedly toggles between the four different widths.

New to FCP 4 is another way to create different track heights. To change a track’s
width, just click between the track names (on the black line between them) and
drag. In Figure 3.25, the audio track A1 has been expanded to show its waveform
better. You can change the height of any audio or video track. If you Cmd-click
a track to create a different track height, you can change all tracks of that type at
the same time. In other words, if you Cmd-click to change a video track height,
all video tracks follow suit. The same is true of audio track height adjustments.

FIGURE 3.25 Individual track height adjustment.

04 2816_CH03  11/11/03  12:44 PM  Page 85



86 Jerry Hofmann on Final Cut Pro 4

� Track Layout menu—As shown in Figure 3.26, this pop-up menu lets you select
ways to change your view of the Timeline window. The selections are pretty
self-explanatory, but note that you can save and restore custom layouts of the
Timeline window from this menu. These files are saved in the
User>Library>Preferences>Final Cut Pro User Preferences>Track Layout folder.
These user preferences can be copied from one computer to another for a quick
“custom setup.”

FIGURE 3.26 The Track Layout pop-up menu.

� Zoom control and the zoom sliders—The small box with an arrow and tick
marks is the Zoom control, and the sliders go across most of the bottom of the
Timeline window. Both are used to navigate around your sequence.
Experimenting with them is probably the best way to get a handle on them. You
activate the Zoom control by clicking and dragging the gray pointer to the left
to zoom in and to the right to zoom out. The zoom sliders to the right of the
Zoom control provide more control. The handles on the end of the gray bar do
the zooming in and out. Clicking and dragging the bar itself moves your
Timeline left and right, as do the arrows at either end of this control.

Across the top of the window is a ruler with time-code numbers to give you a rough
idea of the Timeline’s time code. When you click here, your playhead jumps to where
you click, as shown in Figure 3.27. If you zoom all the way into your sequence at the
playhead’s position, you see a shaded line next to it. This line represents the dura-
tion of a single frame. This extreme zooming in helps you when you do audio
intraframe editing, for example. The waveforms displayed here are much easier to
edit when they are zoomed all the way in.

FIGURE 3.27 Timeline ruler, snapping, and linking controls.
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The default setting of Final Cut Pro 4 has two buttons in the upper-right corner of
the Timeline. The one with the arrows turns snapping on and off. If it’s on, the posi-
tion indicator jumps into position at edit points, markers, and in and Out points.
With it turned off, you have more precise control of areas near these points.

The icon that looks like an 8 leaning over is the Linked Selection control. Clicking a clip’s
audio or video track selects any item that is linked to that clip if the Linked Selection
button is activated. For example, if you click a video clip that has sync sound associated
with it, the sync sound item also is highlighted. It’s a way to keep edits you make that
might affect sync to keep you in sync, or a way to move a video clip whose audio needs
to go with it. For more information on the use of linking, see Chapter 8, “Audio Filters,
Timeline Editing, and Keeping Sync.” There will be times when you don’t want to select
linked audio and video at the same time, such as when you want to keep video but lose
the sync sound or vice versa. Turning off this option lets you do so.

The controls on the far right, below the two buttons we just discussed, let you scroll
up and down to reveal more tracks of audio or video (see Figure 3.28). The center con-
trols move the divider around. It can be placed in various places in the Timeline. For
example, you can separate the video from the audio or slide the divider to be between
another set of tracks for organizational purposes. If you are viewing all the tracks in
your sequence, the sliders disappear. They reappear if you add more tracks that
remove some of your tracks from the viewing area. In the lower-right corner is a han-
dle that sizes the whole window. Simply click and drag to resize. Hopefully you might
begin to see the advantage of a larger screen space. The larger the Timeline window,
the quicker you can navigate it, because you can see more of it at one time.

FIGURE 3.28 Controls along the far right of the Timeline window.
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The Tools Palette
Figure 3.29 shows the Tools Palette. Final Cut Pro gives you seven different ways to
select objects with your interface. The first three buttons are all types of selection tools.
Press A on the keyboard or click the first button to activate it. You use this tool to click
icons, command buttons, clips in the Canvas, and more. Its use is familiar. In some
instances, when another selection tool is chosen, if you move the mouse from the area
of its unique use (usually the Timeline), the selected tool defaults back to this tool.

FIGURE 3.29 The Selection tool.

The next tool down, shown in Figure 3.30, is another set of selection tools that work
only in the Timeline window. Notice that this button has a small arrow in the upper-
right corner. In fact, all the buttons beneath the first one have these arrows. They
indicate that if you click and hold the button, more buttons pop up.

FIGURE 3.30 Specialized selection tools.

When you click the second button from the top, you have three choices: the Edit
Selection tool, the Group Selection tool, and the Range Selection tool. The last tool
selected in the group remains on the top of the Tool window until another is selected.
Pressing G on the keyboard toggles through the selections. You press G once for the Edit
Selection tool, again for the Group Selection tool, and again for the Range Selection tool.
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The Edit Selection tool selects the edit point closest to the playhead’s position and
opens the Trim Edit window. You also can activate this tool by pressing V on the key-
board. The Group Selection tool selects whole clips or sets of clips. The Range
Selection tool selects an area of material not limited to whole clips. You can select
frames of a single clip or set of clips with the Range Selection tool.

Below the Edit Selection tools is a set of Track Selection tools (see Figure 3.31). They
allow you to select whole or large parts of tracks or clips. When you click in the
Timeline with one of these tools, the clip under where you click and all clips in the
direction of the selection tool’s arrow are selected. The single arrows select single
tracks, the double arrows select all tracks, and the two-headed arrow selects entire sin-
gle tracks per click. Say you want to select two entire video tracks out of five. You’d
use the two-headed arrow to select the first track, hold down the Cmd key, and then
select the other track. We’ll experiment with these tools in the Workshop. Linking is
discussed in detail in Chapter 8.

FIGURE 3.31 The Track Selection tools.

The next set of buttons, shown in Figure 3.32, are Trimming Edit tools. With them
you can perform a ripple or roll edit in the Timeline and in transitional effect win-
dows. Ripple edits perform moves on edit points that affect the length of the
Timeline. As you add or subtract frames, the Timeline “ripples” shorter or longer. You
can add a frame to a clip, move all clips down the Timeline a frame, and so on. Roll
edits move an edit point sooner or later in your sequence, adding and subtracting
frames at the same time on each side of the edit point. This procedure does not
lengthen the sequence. Instead, it shortens one side of the edit as you lengthen the
other side, keeping your sequence the same length.
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FIGURE 3.32 The Ripple and Roll edit tools.

Below the Ripple and Roll edit tools are the Slip and Slide tools and the new Time
Remap tool (see Figure 3.33). The Slip tool slips a previously edited clip’s contents
later or earlier without changing the clip’s duration. The Slide tool preserves the
clip’s contents but changes where the clip resides in your sequence, moving the clip’s
In and Out points simultaneously. Neither tool lengthens the duration of the
sequence, because they don’t change the clip’s duration.

FIGURE 3.33 The Slip and Slide tools and the Time Remap tool.

With the Slide Edit tool, the in and Out points of the clip you are affecting stay 
constant while the clip’s position relative to the clips on either side of it changes as
the fixed duration clip moves earlier or later in the sequence. With the Slip Edit tool,
the Out point of the clip before is fixed, as is the In point of the clip following, 
but the clip being slipped moves past the opening between the Out and In points of
the clips on either side of it.

The new Time Remap tool applies a variable-speed effect to your edit. It works in
forward or reverse motion. This new effect is a real-time effect, whereas the constant-
speed changes in earlier releases are not. Constant-speed changes alter a clip’s 
duration. Variable-speed changes applied with the Time Remap tool do not change
the clip’s duration.
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There are four places you can make a variable-speed change with the Time Remap
tool: in the Timeline, in the Viewer’s Motion tab, in the Motion bar under the clip,
and in the Timeline’s keyframe editor time graph. Making these changes in the
Timeline is probably easiest. You can choose to display speed indicators and a
keyframe graph under the clip you are affecting in the Timeline. We’ll experiment
with this tool in the Workshop to get a handle on it.

Next in line are the Razor Blade tools, shown in Figure 3.34. They are fairly straightfor-
ward. The single blade splices and creates a new edit point within a clip on a single track
in your sequence, and the double blade slices edit points through all tracks. You could
use this tool to slice a portion of a clip to remove that portion, for example. Pressing
Ctrl+V accomplishes the same function on any targeted video or audio tracks at the play-
head’s position. Keep in mind that the double razor creates a new edit point on all tracks.

FIGURE 3.34 The Razor Blade tools.

The next tools are the navigational tools (see Figure 3.35). The magnifying glasses zoom
in or out in the Timeline and in the Viewer and Canvas windows. The magnifying glass
with a plus sign zooms in, and the magnifying glass with a minus sign zooms out. The
plain hand tool moves your image around in the Canvas, Viewer, and Timeline win-
dows. The hand with the arrows scrolls through video in the Timeline’s and Browser’s
thumbnail pictures when you view your clips as small, medium, or large icons.

FIGURE 3.35 Navigational tools.
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Next are the Crop and Distort tools (see Figure 3.36). The Crop tool (the one select-
ed in the figure) hides or cuts off a portion of your picture for final viewing. The
Distort tool drags any or all of the four corners of your image to any point on the
screen. The Distort tool is useful for mapping a picture to a billboard that is shot at
an angle, for example. These tools are used in either the Viewer or Canvas window
when they are viewed in the Wireframe or Image + Wireframe views. These two tools
parallel the numeric entries in the Motion tab.

FIGURE 3.36 The Crop and Distort tools.

The last set of tools in the Tools Palette is the Pen tool set, shown in Figure 3.37.
There are three of them. The plain one sets keyframes in the Viewer, Canvas, and
Timeline. The pen tool with the minus sign removes keyframes. The pen tool with
the inverted U is the Pen Smooth tool. Smoothing keyframes creates a change
between two keyframes that is not linear in its movement between the smoothed
keyframe and the next one. The Pen Smooth tool adds bezier handles to the
keyframe in the Canvas and Viewer, to keyframe markers in the Motion and Filter
tabs, and to the Timeline keyframe graphs.

FIGURE 3.37 The Pen tools.
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What Are Tooltips?
Tooltips are small yellow boxes that appear when you hold the selection tool over them
for a few seconds. These are the Tooltips referred to on the General tab of the User
Preferences window. Each name has a letter and/or number after it. These are the
default keyboard shortcuts for these tools. Tooltips appear as long as you’ve set this
function in the General tab of the User Preferences. In most cases, the cursor needs to
be over the button for the Tooltip to appear, but for tools that aren’t the default tool,
you need to click and hold. But in most cases you don’t need to click at all. Most of the
buttons on the interface use Tooltips. It’s a great way to learn the default keyboard com-
mands. As you work with Final Cut Pro, you’ll discover Tooltips and how they operate.
Note that for a Tooltip to show for a specific control, the window that contains the con-
trol must be active.

While we’re on the subject, I’d like to share with you my view on using the mouse ver-
sus the keyboard shortcuts. When you are new to a piece of software, the mouse can be
your best friend. You like having a visual way of commanding the software to do what
you want it to do. With the new keyboard remapping feature (discussed in Chapter 4,
“Organization and Basic Editing”), this might be the way you always want to control
Final Cut Pro. But after you’ve learned what your software can do, it’s a huge timesaver
to use keyboard shortcuts. There are hundreds of them. A partial list of them appears in
Appendix D, “Keyboard Shortcuts.” As we edit the movie, we’ll discover some of them.
But there is no doubt that you should learn to use them. The new keyboard remapping
feature can make this a very personal way of working with Final Cut Pro.

Postproduction is always the last thing that happens in the process of producing shows.
Unfortunately, it is the editor who usually delivers the final product and is up against the
final deadline. If you are fast at using your edit tools, one of two things happens. If you
bid your work as a flat fee, you make more per hour. But far more importantly, if you
have a deadline that cannot be moved, when you are fast at commanding your com-
puter to do what’s needed, you have more time to try what-ifs: What if I edited this way
or that way? You end up with a better edit if you have more time to experiment. Each
time you move your hands from the keyboard, you lose time. Over a period of hours,
this really adds up. After you’ve spent time thinking about what you want to do, why
waste time getting it done? Time is a killer. You’ll be hired more often and be viewed as
an expert instead of an amateur if you use keyboard commands.

Learning keyboard commands is a one-at-a-time process. After you’ve learned to mouse
to commands, it might feel awkward to learn keyboard shortcuts. Just learn one or two
each session. Continue until they become like riding a bike. You won’t regret it; I
promise. Any seasoned producer will appreciate your speed. I’m talking about getting
rehired for the next job. In the long haul, you’ll spend about a fifth as much time using
a keyboard command than you will using the mouse to get to the menu or button that
invokes it.

continues
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Here’s one other thought: You can be more likely to get carpal tunnel syndrome from
repeated mouse movements than from using keyboard shortcuts. In fact, the keyboard
commands used in the process of editing are very unlike a straight typing job. A letter
command now and then is just not as stressful as typing something like this book or
data entries. You can’t get away from using the mouse entirely (nor should you), but
you certainly can minimize its use.

Workshop 3: Load the First Project and Become Familiar
with the Navigational Controls and Window Arrangement

Learning to navigate easily and efficiently with the default set of windows should be
the first task you really feel comfortable with. You’ll use these windows so much that
mastering the navigation techniques becomes mandatory. As you edit the movie,
you’ll find lots of ways to ease your workflow as soon as you understand workspaces
you can create. In this workshop, you’ll open and save the project files as well.

Load the Project’s Files
The first thing to do is load all the DVD’s project and media files onto your
computer. They are located in two folders—Project Files and Media Files. If
your computer has only one hard drive, click each folder one at a time from
the DVD, and unstuff (decompress) them to your hard drive in a place that
makes sense to you. If you have more than one drive, click the Project Files
folder and drag it to your startup disk, and drag the Media Files folder to your
second disk, which usually should be reserved for holding media files only.

1. Open Final Cut Pro. If you have a project already started, Ctrl-click its tab in the
Browser window, and close it. Press Cmd+O or select File, Open. Open the project
file called Project 1.

2. Final Cut Pro warns you that it’s missing media files. All the clips are offline, with
red Xs in them. You need to reconnect them to the media files you copied in Step
1. Remember, they are just reference files that point to the actual media files. You
know that the media files are there. It’s just that they are not in the same place
they were the last time this project was opened, so you need to tell Final Cut Pro
where they are stored now. The same thing will happen if you move media files
in the future or rename their folders from the Mac desktop. Highlight everything
in the Project file’s Browser (just click on the Brower and type command + a) and
select “Reconnect Media” from the File menu to reconnect these reference files to
the place you installed the media files when you copied their folder from the
DVD. Another way to reconnect files is to highlight them in the Browser, 
Ctrl-click one of them, and select Reconnect Media.
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Final Cut Pro’s dialog boxes will ask you to find three files. The first of these is the
“Boat Composite.” You’ll find this file in the “Compositing Material” file folder.
When you open the folder, you’ll see it at the top of the list, click on the “Matched
Name Only” selection and also the “Reconnect All files in Relative Path” selection,
then  Click “Choose.” Do the same dor the second file “1 hr timecode section” you’ll
find in the “Picture Clips” folder, and the same for the “B-Last Poem Clean” clip
you’ll find in the “ALL Sound Clips” folder. The rest of the files will reconnect auto-
matically. As you import files, these three folders are where you’ll find the media files.

3. Now all the entries in your Project 1 file are online, meaning that they are point-
ing to actual media files on your computer and are ready and available for use
within your project. They should not have red lines through them (see Figure
3.38). Highlight the Browser window and select File, Save Project As. Rename this
project file Project 1 (your name).

FIGURE 3.38 The Browser after reconnection.

4. Double-click “The Midnight Sun Finished Sequence” if it is not already open in the
Timeline. This is the sequence you will build. It’s included with the project file for
reference if you need to look at it. We’ll use it now to learn some navigation and
viewing techniques. You may have to render everything in the sequence in order
to play it back, and you should do so now.
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The way to render everything is to open the “Midnight Sun Finished Sequence”
by double clicking its Icon in the Browser. It opens in the Timeline Window. With
the Timeline window active, type Command+A. Open the Sequence Menu and
turn on every item in the “Render All” submenu (the check marks for each item
will appear one by one). After you’ve selected them all, type Option+R to begin
the rendering. Watch the movie so you know where we are headed, and familiar-
ize yourself with the footage at the same time.

Arrange Windows and Viewing Options
1. The most efficient way to ease your workflow is to select the Window, Arrange com-

mand. A pop-up menu reveals a list of standard arrangement views and a way to cus-
tomize window arrangements you want to use in this or any project (see Figure 3.39).
The figure shows the options available with dual computer displays. FCP recognizes
your computer’s setup. Familiarize yourself with the standard setups available on
your system by clicking each of the standard arrangements your setup provides.
Especially note the new Multiple Edits arrangement and the Audio Mixing arrange-
ment, which introduces FCP 4’s Audio Mixer. We’ll use it in many later Workshops.

FIGURE 3.39 Options available for dual computer displays.

2. Select the Multiple Edits arrangement (Figure 3.40) and experiment with the views
available in the new Frame Viewers (see Figure 3.40). Note that there are still Viewer
and Canvas windows in this arrangement, but two Frame Viewers are present in
Tool Bench windows. Tool Bench windows can contain other tools as well, notably
the set of Video Scopes and the new Audio Mixer. We’ll use these tools as we edit
the movie, but experiment with the Frame Viewers now. Frame Viewers can display
side-by-side views of two different clips at the same time. Note that if you are 
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working on a display that cannot display higher resolutions than 1280×854, the
Multiple Edits arrangement is unavailable. If so, select Tools, Frame Viewer or press
Cmd+7. Pressing Cmd+7 again opens a second Frame Viewer. You can drag the tab
of the Frame Viewer from the Tool Bench window to see more at one time.

Frame Viewers are particularly helpful when you’re color matching two clips. In fact,
you can have many of them open at one time to see a whole range of clips in your
sequence at once. You can even select the same frame to make one side a “before the
filter is applied” view and the other side an “after the filter is applied” view.

Figure 3.40 shows five consecutive edits in the Timeline and a standard Viewer
window. The current frame of the Timeline’s playhead is displayed in the Canvas.
Moving the Canvas’s playhead updates all five frame views. The “standard” Viewer
is left unchanged.

FIGURE 3.40 The Multiple Edits arrangement.

3. The pop-up menus on the bottom of the Frame Viewers allow you to split two 
picture views vertically or horizontally, as selected by the buttons at the bottom 
of the Frame Viewer. You can see various clips side by side this way. You can even
swap which clip is displayed on which side by clicking the Swap button. This is
perfect for matching color corrections, for example. Click and drag the green or
blue buttons in a corner of one of the Frame Viewers to do your own “split screen”
shapes of the two clips being viewed.

4. In the Frame Viewer on the far right in the Multiple Edit arrangement is a tab that
reveals FCP’s Video Scopes. You will read more about them later, but note that
they are part of this window arrangement. Click the Video Scopes tab to look at
these scopes. If you are working on a system that cannot display this arrangement,
open the Video Scopes by pressing Cmd+9 or by selecting Tools, Video Scopes. As
with Frame Viewers, you can open more than one set of Video Scopes.

5. Activate the Hand tool by dragging one of the two clips in a Frame Viewer. You
can even drag which portion of a clip is being viewed, and can resize the split
screen effect by dragging on one of the colored corners in this window.

6. When you are done experimenting, select Window, Arrange, Standard or press
Ctrl+U.
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Resize the Windows
1. Customize the arrangement of these four windows. Play with the sizing buttons.

Start with the three buttons in the upper left of each window. Each of the four
big windows has a handle in the lower-right corner. This handle sizes the window
individually when you drag it. The only way to drag and move an entire window
is by grabbing its uppermost bar. If you double-click this bar, the window is mini-
mized to the dock. Clicking it again brings it back to its last position. You might
want to do this to access the desktop, for example.

2. When you’re done, reset the arrangement to the standard arrangement.

3. Final Cut Pro 4 adds a new way to arrange windows. If you move the mouse
pointer between any two windows and then click and drag, you can resize all 
(or some of) the other major windows at the same time, making room for the
window you want to enlarge. The currently selected tool changes to a resize
pointer when you move it between any two of the four major windows. Try this
between the Viewer and Canvas, and then between the Canvas and Timeline or
Browser and Timeline windows. Pretty cool, eh?

4. When you are done, reset your arrangement to Standard again.

Save Window Arrangements
1. The Window, Arrange submenu has two ways to save arrangements. The first is to

use the options Custom Layout 1 and Custom Layout 2. To save a layout, arrange
your windows, hold down the Cmd key, and select Window, Arrange, Set Layout
1 or 2. You can save two different layouts, and they will be tied to this project file
only. You can start by arranging the windows in the standard way. Set up an
arrangement that maximizes the Browser’s size and diminishes the size of the
other windows using the resize pointer. Then save this view as Custom Layout 1.

2. If you want to save a view for use in all projects, select Window, Arrange, Save
Layout. After you have named and saved a view, Restore Layout brings up this
arrangement of windows in any project you work on in the future. You can then
start a new project and restore these saved layouts whenever you need them.

3. While using FCP, you might inadvertently hide a window. Restoring layouts or
recalling the standard set of arrangements brings them forward, as does calling up
custom window arrangements and layouts. Where many users get confused is when
they close the Canvas window and the Timeline window closes with it. Double-
clicking a Sequence icon in the Browser opens these two windows, with the
sequence in the Timeline window. Open the Browser window by dragging it to the
top left of the display, and then drag its lower-right corner until it fills the display.

4. Then select one of the arrangements to quickly put it back in its place and reveal
all the earlier hidden windows.
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Navigate the Browser
Because you use the Browser to locate all your source material, it’s wise to learn
how to navigate it with ease. Using the techniques described below should get
you on your way.

1. Click the arrow (the disclosure triangle) next to the Picture Clips folder (bin) to
open and close this bin from within the Browser window. Double-click the Picture
Clips folder (bin) icon and open it in its own window. Drag the tab in this win-
dow to the Browser window’s tab area. You can now access this bin from the
Browser by clicking its tab. It’s a great way to access often-used bins. This is
important if you have a lot of them. Documentary and feature editors will appre-
ciate this. Ctrl-click the Picture bin’s tab to close it from the Browser’s tabbed area.
It’s still accessible from the Browser and its window. Try it.

2. Hold down the Cmd key while you double-click the Sound Clips bin in the
Browser. It opens as a tabbed bin in the Browser. Either Ctrl-click its tab to close it
from the tabbed area of the Browser or open it from the Browser’s list and close it
from the tabbed area.

3. If you close or hide one of the six major windows, you can open it again from the
Window menu. Notice that most of the window names have keyboard shortcuts
listed next to them. These shortcuts are displayed next to all commands that have
them in all the pull-down menus. This is a great way to learn the keyboard short-
cuts for the commands you use frequently. Close the Viewer window, and then
open it again by pressing Cmd+1. Close the Tools Palette, and then reopen it by
selecting Window, Tools. Try closing the other windows and using the Window
menu to open them back up. Be sure to close the Timeline window and then
reopen it by double-clicking “The Midnight Sun Finished Sequence” in the
Browser. One anomaly of this behavior is when you close the Canvas. The
Timeline window also closes, but double-clicking any sequence opens them both
back up.

4. Open the Picture Clips bin by double-clicking it. Ctrl-click the light gray area
away from a clip’s name, but within the Name column. You see the pop-up menu
shown in Figure 3.41. If the bin is not opened as large as it is in the figure, there
might be little arrows at the top and bottom so that you can scroll through this
menu. Near the bottom of this menu is a set of four viewing commands. Click
each to discover how it changes your view of this information. Choose View as
Large Icons, and Ctrl-click the window’s gray area between two clips to access the
pop-up menu again. This time, select Arrange. If some of the clips were off the
picture before, they might come into view. This can be helpful when you have
many clips.
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FIGURE 3.41 The context menu found in a bin or in the Browser.

5. Close the Picture Clips bin. Use the disclosure triangles next to the Sound Clips
bin in the Browser to reopen it. Use the scrolling bar across the bottom to drag
through all the information kept for each clip. Try clicking a column’s name
heading to sort that column’s data in ascending or descending order. The arrow
in the column name header tells you the sort order and which column you are
sorting, as shown in Figure 3.42. Adjust the width of the Name column by click-
ing in the area next to its divider mark at the top between the Name column and
the column to its right, as shown in Figure 3.43, and drag with the resize tool
(which automatically appears) to increase or decrease the column width. Also
note that you can drag the column names to rearrange their order, as shown in
Figure 3.44.

FIGURE 3.42 The sorting arrow display.
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FIGURE 3.43 Sizing column widths by dragging the line between them in the column heading with 
the resize tool.

FIGURE 3.44 Click and drag the column name to reposition the order of the columns.

6. Ctrl-click these top column names. A context menu allows you to show more or
different columns, as shown in Figure 3.45. You can choose from a Standard or
Logging setup. This can help if you have many clips.

FIGURE 3.45 The Column Names context menu.

7. Open the Sound Clips bin by double-clicking its icon. Then maximize the bin
window to reveal as much of it as possible by clicking the green maximize button.
To move the Tracks column next to the Name column, click the Tracks column
name and drag it to the left, next to the Name column. Then Ctrl-click each of
the columns except Name, Tracks, Duration, Media Start, Media End, and Size,
and select Hide until only these six columns remain.
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8. Ctrl-click the Tracks column and select Save Column Layout. Name the layout
“minimal layout,” and click Save. Restore the Logging column’s layout by Ctrl-
clicking the Tracks column heading and selecting Logging Columns.

9. Ctrl-click the Media Start column and select Standard Columns to restore it to its
original set of columns. You can also save a column layout that includes only the
information you need to quickly review, such as a Label or Scene Number column.

It’s important to know that you can minimize what you must view in order to
locate source material quickly. Sorting columns also can help you find just
what you’re looking for. You can sort any column by clicking its column head-
ing. Also keep in mind that you can start with the Standard or Logging layouts
and customize them. When you are done with this exercise, select Window,
Arrange, Standard to put your view of the interface in order again.

Navigate the Viewer and Canvas Windows
After you’ve selected what you want to edit by finding it in the Browser, you
need to understand how to get around the Viewer and Canvas windows. The
following exercises get you on your way.

1. From the Picture Clips bin, open the disclosure triangle next to the 1 hr time-code
section Master clip, and then double-click the “Cap up mtn side dusk” marker.
(We’ll discuss markers in the next chapter. In this case, it was added as a mark you
can quickly navigate to from within a clip.) The clip opens in the Viewer window.
Play it by pressing the spacebar, clicking the play button in the Viewer window, or
pressing the L key. The K key stops playback, and the J key plays backwards.
Pressing the L key twice plays double speed, three times plays triple speed, and
four times plays quadruple speed. The same goes for the J key, except that the
video plays in reverse. Holding down the K key and the J or L key plays the
footage forward or backward at about half speed. If you press L four times and
then press J twice, you slow down forward playback to double speed, thus allowing
you to decrease the speed as you approach the area you’re looking for.

2. Holding down the K key while pressing the J or L key moves the video one frame
at a time. This is a great way to “creep up on” a frame. Take some time to use all
the navigation buttons immediately below the scrubbing bar. Click around the
scrubbing bar to quickly navigate through the clip in the Viewer. You can scan 
by clicking and dragging through the scrubber bar as well. Keep in mind that 
you can do all these things in the Canvas window too as long as it’s the active
window. Spend some time with all these navigational techniques to become 
more familiar with them. Try them all and learn them. If you use the keyboard
commands to navigate in the Viewer and Canvas windows, you will find the
frames you’re looking for much more efficiently.
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Navigate the Canvas and Timeline Windows
When you navigate in the Canvas or Timeline window, you navigate in both
windows, because they are tied to each other. Moving the playhead in the
Canvas moves it in the Timeline, and vice versa. You need to master the navi-
gation of these windows. The following exercises get you started.

1. Double-click the sequence titled “Sequence 1” in the Browser window if it is not
already the open sequence in the Timeline window (it should be an empty
sequence). You mark clips for editing with the two buttons in the Viewer and
Canvas windows or with the I or O key. Mark an In point and an Out point for a
short duration in the “Cap up mtn side dusk” contained in the Viewer. Set an In
point (I) near the beginning of the actor’s walk up the hill at 01:13:24:04. Type
+3622 in the upper-right time-code display box to jump 36 seconds and 22 frames
farther into the clip. Type an Out point (O). Notice that the upper-left time-code
display now shows a duration of 36:22. Click in the center of the picture in the
Viewer window, and drag the ghosted square from there to the Canvas window
highlighting the Insert command.  Click the center of the Viewer window and
drag directly down to the Timeline window, placing the clip in your sequence just
past the earlier clip. Either dragging to the Canvas overlay or directly to the
Timeline Window puts your material in your sequence. Highlight the first clip and
press the Delete key. Now you have only the second clip. Take some time to navi-
gate the Canvas window with this clip in it. All the same techniques of navigating
in the Viewer work in the Canvas and therefore in the Timeline window as well.

2. Settle on a frame somewhere in the middle of the shot in the Canvas, and click
the Show Match Frame button (in the lower-right corner of the Canvas window)
or press the F key. The same frame appears in the Viewer window. Now move the
Viewer’s clip somewhat and press F again. The same frame appears in the Canvas.
You can use this command to see if you’ve already used material in the sequence
(in the case of match framing from the Viewer) or to pull a clip into the Viewer
from the Canvas for viewing purposes.

3. Click the Toggle Timeline Track Height button. The four track height selections
are shown in the lower left of the Sequence menu. Notice that they can easily be
changed. You can also press Shift+T repeatedly to toggle through the different
track heights. Wherever you navigate in the Canvas window, you also navigate at

If your mouse has a scroll wheel, you can use it to navigate through any active win-
dow that has vertical scroll bars, such as the Browser or the Timeline window, when
working with more tracks than you can see at one time. You can use the scroll wheel

to scroll up and down to reveal tracks hidden by a Timeline window that is too small to display
them all. You can use a second (or third) monitor to display the Timeline and make it as tall as
the monitor. This is wonderful when you’re working with many audio and video tracks.
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the same time in the Timeline window. You can use the earlier controls in the
Canvas, or you can click the ruler in the top of the sequence in the Timeline 
window to move around. You can also move around the Timeline by clicking
around the scrubber bar at the bottom of the Canvas window.

4. If it isn’t already open, open “The Midnight Sun Finished Sequence” by double-
clicking it or by clicking its tab in the Canvas or Timeline window if it is already
open. Experiment with the navigational sliders at the bottom of the Timeline
window. Pay close attention to the handles at either end of the bar. If you move
them, you expand or contract the view of the Timeline. If you slide the slider,
you move earlier or later in the Timeline.

5. Press Cmd+3 to make sure the Timeline window is active. Press Shift+Z to fill the
Timeline window with the entire sequence. Press Z to activate the Zoom tool.
Draw a box starting in the area above all the tracks in the Timeline and “lasso” 
a few clips in the center of the sequence. Note that you just zoomed in on that
particular set of clips.

6. Press Shift+Z again to zoom back out. You see the entire sequence, no matter
what size the Timeline window is set to. I find this the most efficient way to
zoom in and out of the sequence in the Timeline window. Using the Zoom tool
in the Timeline, Viewer, and Canvas windows zooms in. Pressing Shift+Z with
one of these three windows active zooms back out. In the case of the Canvas and
Viewer, this sets them to be “Fit to Window.” You’ll find that the most reliable
playback of your clips and sequences happens when these windows are set to 
Fit to Window.
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